HIGH RESOLUTION CAMERA KIT

C-MOUNT ASSEMBLY

This quick reference guide provides instructions for assembling the mounting arm and setting up the high
resolution camera in Qbit-DB. Before beginning, ensure that you have all the necessary components, in-
cluding the mount assembly and camera.

CAMERA SETUP

Follow the steps to attach the mounting arm to the
side of the cart and set up the camera.

1. Before mounting the camera, locate the M12
X-Coded cable and plug it into the camera’s
M12 Ethernet port. When plugging in the cable,
align the indentation so that the cable and port
pin holes line up correctly.

Do not force the cable into the port, as it may
damage the pins. Once the cable is correctly
aligned to the port, screw in the cable.

2. Attach the lower assembly of the mounting arm
to the side of the cart with the provided 1/4”
hex bolts and flange nuts. Two bolts secure the ‘
(a) lower plate and two the (b) upper plate.

3. With the lower assembly securely affixed to the \ /
cart, assemble the upper arm. Slide the upper i
arm into the base of the lower arm. Rotate the
upper arm as needed to ensure the camera is
properly aligned with the gate.

4. Secure both pieces with the provided M3 screw.

5. Remove the dust cap from the camera and
screw on the lens until there is contact with the
front base of the camera.

6. A small indicator light will blink red, when the
camera is powered on. This light will begin
blinking green when the camera is ready to
stream.
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INSTALLING BACKDROP

To attach the white backdrop to the CS 325, &
complete the following steps:

1. Remove the four corner screws securing the
black Cubiscan cover.

2. Slide the white backdrop over the Cubiscan
cover. The backdrop should be aligned with
the back of the cover, allowing free move-
ment of the chain belt.

3. Secure the backdrop and cover with the four
5/8" screws included with the kit.

If necessary, lift the glass off of the Cubiscan
to access the screws.

CONNECTING TO QBIT-DB

111914076 Application startup ...

; 11:1%:14:134 Select "Tools # Options" to zet the zenial port number
Complete thg.folloyvmg steps to connect the 11:19:14:134  Starting overhead camera interface
camera to Qbit-DB: 111914134 Connected to OBIT_DEFALLT
11:1%:14:134 Successful connection to overhead camera socket.
1. Install and open Qbit-DB on your comput- 11:153:14:134 Opening table --> ITEM_INFD
er. The status window of the main screen 11:13:14:146 CubiScan Model 323 Selected
e 11:1%:17:018 Successful connechon to overhead camera. ..
will indicate that the camera has connected 11:193:17:990 Pleaze wait while the overhead camera streaming process is started. .
co rrectly_ 111319726 Owerhead camera streaming started. .

If this is not shown, ensure the camera is
powered on. You may also restart the cam-
era and computer.

Image options  Auto transfer 20 images

Overhead camera options (Beta) Deprecated Cameras

If the problem persists, please contact

Cubiscan Service and Technical Support at e Elrsnirbatrmetais 1
| [[]Enable overhead camera |
801.451.7000 for assistance. T
. [ Wait forimage before auto-updating
2. Once connected, navigate to the Images tab Wait for image on ato update fimeott {ms)
located under Tools > Options. 5000
Camera port number
3. Select the Image options tab. Under Overhead o
camera options, check the box next to Enable ! — |

overhead camera. | tmmmmmmmmem==d

4. Click [Calibration] to set up the camera accord-
ing to your desired specifications.
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CALIBRATION OPTIONS

The Calibration menu has four tabs: General,
Raw Crop/Zoom, Exposure, and Object Detec-
tion. Under each tab are options to calibrate the
camera.

General Tab
Rotate image: Images may be rotated 180 de-
grees (0 = disabled, 1 = enabled).

File extension type: Click the drop-down menu
to select the image output file type. Options
include jpg, bmp, tiff, or png.

Debug mode: The value may be set from 0 to 5.

Raw Crop/Zoom

Raw image crop/zoom: Determines the default
zoom percentage used when no other manual
override is performed (0 = disabled, 1 = en-
abled).

Raw image crop/zoom percentage: Enter a val-
ue between 0 and 100, representing the percent-
age of zoom (larger percentage = greater zoom,
smaller percentage = lesser zoom).

Exposure

Most values in this tab are preset according to
best performance under most conditions. These
values should only be adjusted for specific rea-
sons to allow for better image capture.

Frame rate enabled: Enables custom frame rate.

Frame rate: A larger frame rate will affect ex-
posure. Use this value to adjust brightness and
performance.

Exposure auto: Sets to continuous, allowing the
camera to detect the best lighting exposure. Set
this to manual to enter preferred values.

Exposure time: The exposure time may be set
manually with ranges dependent on camera
settings. Increasing the exposure time will allow
the aperture of the camera to remain open lon-
ger, allowing for a brighter, more robust image.
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General Raw Crop/Zoom  Exposure  Object Detection
Object detection calibration

Rotate image
0

File extension type

Jpg W
Debug mode

0

General Raw Crop/Zoom  Exposure Object Detection

Object detection calibration

Faw image crop/zoom

o

Faw image crop/zoom percentage
30

General Raw Crop/Zoom Exposure  Object Detection

Camera Calibration

Snapshot Snapshot

Frame rate enabled
falze w

Frame rate (Range 0.40 - 0.5)
000001.00

Exposure auto
Continuous ~

Exposure time (Range 359.32 - 1917341.2)
053200.00

Gain auto

Continuous ~
Gain amount (Range 0.00 - 27.0)
000022.00

Gamma enabled
false £

Gamma amount (Range 0.2 - 2.)
000001.00
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(Note: long exposure times can also lead to
blurring of the image)

Gain auto: Defaults to continuous, allowing
the camera to determine the best gain. Set
this to manual to enter preferred values.

Gain amount: The gain may be set manually

with amounts depending on camera settings.
The gain amount increases the signal intensi-
ty of each pixel, increasing overall brightness.

Gamma enabled: Enables gamma correction
with images.

Gamma amount: Set the gamma correction
with amounts depending on camera settings.
The greater the value, the more the gamma
correction, resulting in a brighter more con-
trasted image.

Object Detection

Detection type: Enter a value of 1, 2, or 3
according to the detected object’s features
(1=largest object, 2= highest object, 3=clos-
est to center).

Color threshold: Sets the allowed pixel dif-
ference between the calibration image and
current image, measured in number of pixels.

Noise filter level: The set value determines
the amount of noise to filter out.

Edge threshold: Determines the threshold
at which detected objects on the edge are
ignored.

Minimum object pixel count: Determines
the minimum pixel count an object may have
before the algorithm ignores it.

Cropping buffer: Allows for extra white space
along the image’s border when cropping.

White border buffer: Creates a white border
of set width around the image after it has
been cropped.

Bypass object detection/cropping: Enable or

disable object detection and cropping (0=on,
1=0ff).
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General Raw Crop/Zoom Exposure Object Detection
Object detection calibraticn

Snap calibration image

Detection type
I

Color threshold
20

Moise filter level
I

Edge threshold
10

Minimum object pixel count

|1DDD

Cropping buffer
|20

White border buffer
|20

Bypass object detection/cropping

|1
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General Raw Crop/Zoom Exposure Object Detection
Object detection calibration

Detecticn type
[1
Color threshold
[20
Moise filter level
|1
Edge threshold
[10
Minimum object pixel count
[1000

Cropping buffer

j20
White border buffer
o0

Bypass object detection/cropping

[

CAMERA CALIBRATION

The camera may be set to the default
of Raw image crop and zoom or Ob-
ject detection depending on the type
and variety of scanned objects.

1.

Before taking snapshots, the cam-
era must be calibrated to the exist-
ing backdrop. This can be done by
clicking [Snap Calibration Image]
under the Object Detection tab in
the Calibration menu.

When calibrating the camera,
ensure the platform is free of all
objects. It may take a few clicks
before the camera is properly cali-

brated.

The camera should be recalibrated
each time the camera parameters
are changed to ensure proper
function.

Once preferred parameters are
set, go to the Exposure tab. Place
an object on the platform and click
[Snapshot Raw] to ensure the cam-
era captures the entire platform.
Adjust the lens on the camera as
needed.

Copyright 2019 by Quantronix, Inc.
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Exposure  Object Detection

Camera Calibration

Snapshot ‘ Snapshet Raw

Frame rate enabled
false v

Frame rate (Range 0.40 - 5.3)
ooo001.00

Exposure auto

Continuous v
Exposure time (Range 359.32 - 188283.8)
[os8200.00

Gain auto

Continuous

Gain amount (Range 0.00 - 27.0)
000022.00

Gamma enabled

false v
Gamma amount (Range 0.2 - 2.)
000001.00

File extension type
bmp.

Apply changes
Exposure  Object Detection

Snapshot Raw |
false

Frame rate (Range 0.40 - 5.3)
[pocoor.co

Camera Calibration

Snapshet

Frame rate enabled

Exposure auto
Continuous

Exposure time (Range 359.32 - 188283.8)
058200.00

Gain auto

Continuous
Gain amount (Range 0.00 - 27.0)
00002200

Gamma enabled

false

Gamma amount (Range 0.2 - 2.
000001.00

File extension type

bmp

Apply changes

}{ minimum pixel threshold = 1000 }{ crop buffer = 20
10:25:00 - Image calibration parameters saved...

}{ border buffer=20 }{ bypass detection = 1

10:27:22 - Applying image calibration values = {Object detection} {method =1  }{ color threshold = 20
}{ minimum pixel threshold = 1000 } { crop buffer =20 }{ border buffer=20 }{bypass detection = 0

}{debuglevel=0 }{image rotation =1

}{noise filter level =1 }{ edge threshold
}{debuglevel=0 }{image rotation =1

}{ minimum pixel threshold = 1000 }{ crop buffer=20 }{border buffer=20 }{bypass detection=1 }{debuglevel=0 }{image rot

10:25:00 - Image calibration parameters saved._
10:27:22 - Applying image calibration values = {Object detection} {method =1 }{ color threshold

=20 }{noisefilterlevel=1 }{edget

}{ minimum pixel threshold = 1000 }{ crop buffer =20 }{border buffer=20 }{bypass detection=0 }{debuglevel=0 }{image rot:
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Bl | pem Mumber Case Size Host System

Stacked QTY | | 466789 \
I = Purchase Order tem Code
Height |1 3] [
<1 || Deseription Lot Code Optionalirfa 7
Llengh |1 5 | ‘
wan [ 5 Lot Expiy Date Optionalinf &
Stacked quaniiyis ‘ P
the rurber of ke :
Sesit st o Cubiscan Database
TR v o Length(in) [ 00000 | 0.0000
dmersinns and Lpdate
weight are calculated Width (in) | 0.0000 | 0.0000
to provide an <Eachy 4 b
measurement Gear- 6 Height(in) [~ 0.0000 I 00000
@ Weight(b) [ o000 | 0.0000
| Snapsnat - F7 Volume (in3) | 0.0000 | 0.0000
& Dim Wagt (166) | 0.0000 | 0.0000
Delete

10:16:38:530 Successhul connection to overhead camera...

101 Please wait while the overhead camera stieaming piocess is starled
Oivsthead camera streaming started..

Successhul object detection manual cveride.

Dizcorrected from Cubizcan 10.1.100.100:1050

scan 10.1,100,100:1050

elecle
10.1.100.100:1050

3. Next, click [Snapshot]. A cropped image
of the object should appear. If the object
is partially cropped, adjust settings to en-
sure the full object appears.

4. Click [OK] from the Options window when
you are finished to close the window and
save desired settings.

5. Return to the measuring screen. Click on
the View dropdown to ensure that Cam-
era image is selected. This will ensure the
Camera image panel is displayed on the
measuring screen.

6. Enter the item number for the item that
you want associated with the picture into
the ltem number field (primary field).

7. Below the item number field are a series
of buttons. When the [Measure] button
is clicked, an image will be snapped and
shown.

8. If the camera was connected to Qbit-DB
successfully, the picture should display in
the camera image window on the main
Qbit-DB screen (shown above).

9. You may alternatively click [Snapshot] to
take a snapshot of the object before a
measurement is taken.
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W=0.0

tem number

1003 Optional info 1 Optional info 5
i’ack e Optional info 2 Optional info 6
i:)escﬂption Optional info 3 Optional info 7
Optional info 4 Optional info 8
0
9 Length (in) | D,Eb:Dl:)giscan [ DIT;;’B
Update - F4 ‘
v Width(in) [ 0.0000 [ 0.0000
Cear-F6 Height(in) [~ 0.0000 [ 0.0000
= Weight(lb) |  0.0000 | 0.0000
Snapshot - F7 Volume (in3) | 0.0000 | 0.0000
FE Dim Wgt (166) | 0.0000 | 0.0000

If a measurement is taken after [Snapshot] is
clicked, no new snapshot will be taken.

If the [Snapshot] button is clicked after a mea-
surement, a new snapshot will be taken, replacing
the previous snapshot taken during the measure-
ment process.

Right-click on [Snapshot] to open a menu dis-
playing various snapshot options to choose from.
The Snapshot menu gives quick access to set-
tings without returning to the Options menu.

801.451.7000

. CUBISCAN
cubiscan.com

~

All rights reserved.



CAMERA SETTINGS

Raw image crop/zoom » 10%

Object detection 20%
If the camera is having difficulty identifying ) _ .

Detection type = largest object 30%

the object or struggling to crop the image
properly, the Snapshot menu gives alternative Detection type = highest ohject 40%
ways for the camera to search for the object.

Detection type = closest to center 0%
It also allows for a raw image to be taken at o pm— :
. oolz A Options" o zet the serial port number RO
various zoom percentages. 1 averhead camera interface
cted to GBIT_DEFAULT 0%
If scanning a wide variety of object sizes and s3ful connection to overhead camera socket... 80%
shapes, it is preferable to set the camera to 1 table - ITEM_INFO

an madel 100 zelected 90,

Raw image with no crop or zoom or Object zsful connection to overhead camera...

detection, making all possibe option available

at the Snapshot menu for possible for manual | e |

override.

The following options are available from the
Snapshot menu:

Raw image crop/zoom: Opens a side menu
with various zoom percentages. The higher
the percentage, the greater the zoom.

Detection type = largest objects: Sets the
camera to detect the largest object on the
platform.

This option is best in cases where the object
detection algorithm cannot identify the ob-

ject due to shadows or distinct features that
distract it from the main object.

Detection type = highest objects: Sets the
camera to detect the highest object on the
platform.

This option may be helpful in cases where
taller objects are being imaged.

Detection type = closest to center: Sets the
camera to detect the object closest to the
platform’s center.

This option is most helpful if is a shadow or
other feature at the edge of the camera view
is prevent the camera from detecting the
object.
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TROUBLESHOOTING

Images are too dark

If images are too dark, brightness may be cor-
rected using the settings exposure time, gain,
and gamma correction (see Camera Settings).

If changing these settings does not correct the
issue, the F-stop on the camera may need to be
adjusted manually.

1. The set screw closest to the camera housing
adjusts the F-stop. Loosen the set screw and
set the F-stop value to 8.

2. Snap a new picture to see if the exposure has
improved. Countinue adjusting the F-Stop
value until the image is at the desired bright-
ness.

Images are blurry

If images are blury, the focus will need manual
adjustment as follows.

1. Loosen the set screw that is closest to the end
of the lens. This screw holds the focus ring in
place.

2. After loosening the screw, turn the numbered
ring closet the lens to adjust the focus. The
prefered setting is slightly off of infinity, some-
where between 1 and 2.
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